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REBEL Output File Types – What you’ll find in your Batch folder

User-Focused
1. Comma-Separated Values (.csv) files are created to store PATsmart REBEL® System data output

a) The entire batch file always ends in “Results.csv” – Go-to file for processing and analysis as it contains
ALL data

b) Each replicate within a batch has a dedicated .csv file – May also be used to process data

c) The batch file with the same name but without “Results” is the batch record sheet – Contains batch 
sequence info but cannot be used to analyze results

d) If SIMCA® CSV Reports is turned ON (System Settings > Storage/Export), then a file ending in
“…SIMCA.csv” will be generated – Intended for import into Satorius SIMCA for further processing

2. Report files (.pdf) are also generated for each replicate – Contains analyte concentration, 
percent standard error, and electropherogram (please refer to the “PDF Electropherogram 
Reading Guide” to better understand and interpret the graph

a) Quantitative Calibrations and Performance Qualifications also produce report files

b) Offer quick, summarized, color-coded results for when comprehensive data processing isn’t required
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REBEL Output File Types (cont.)

Support-Focused
1. Telemetry (.tel) files are for Repligen support to analyze and diagnose customer issues and 

REBEL instrument readings
a) If “TEL Data Files” is turned ON (System Settings > Storage/Export), then these files will be

automatically created – ensure it is ON as to not encounter any issues in the future

b) Should be sent ONLY to Repligen support, when necessary

c) Batch and QC .tel files may be uploaded here – only upload at the request of your Repligen
support representative and be sure to include their name in the description: 
https://repligen.com/supportupload/?product=REBEL

2. Assay (.json) files are also generated with each batch run and are required to be able 
to read the .tel files
a) Please email these files to your Repligen support representative whenever you upload any .tel files to 

the link above

b) Are not used for any data processing or viewing and cannot be opened by themselves

https://repligen.com/supportupload/?product=Rebel
https://repligen.com/supportupload/?product=Rebel
https://repligen.com/supportupload/?product=Rebel
https://repligen.com/supportupload/?product=Rebel
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Range Finding Experiment (RFE)

A Range Finding Experiment (RFE) is used to establish which dilution factors (DF) 
might be best to utilize for preparation and analysis of lab-specific samples

The convenient Range Finding Tool (RFT) can be found under System Settings
> Tools to run an RFE batch on fresh media (including supplements if necessary)

Refer to “REBEL V1.2 Dilution Range Finding Tool.pdf” for more guidance

With the modified worksheets you’re about to create from the “Results.csv” file, along with the Range
Finding – Dilution Report PDF & CSV files, will help determine optimal DF(s) needed for sample analysis

Depending on the analytes of interest, one or a few DFs may be chosen for prepping samples to afford the 
most accurate and robust results

• For example, the minimum DF (10x) is usually required to quantify the micronutrients (βAla, B1, B6-OH, B6-Oxo, GABA, NAM, 
and Sarcosine) since they’re conventionally lower in concentration than the AAs in numerous media types across many 
applications – “Recommended” DF would be 10x

• However, 10x is often too low of a dilution for other analytes with higher concentrations, necessitating use of another DF to
allow monitoring of these analytes in the same sample
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Range Finding Experiment (RFE) - Examples

Depending on the analytes of interest, one or several DFs may be chosen from the RFE for preparing each 
sample to generate the most accurate and precise results for all target analytes:
• Example 1: Trent’s T-Cell Lab is interested in only 10 of the analytes monitored by the REBEL and all 10 are observed within 

optimal range at a single DF of 25x. They will only need to prepare samples at DF = 25x for each time point.

• Example 2: Catie’s CHO Lab is interested in 15 of the analytes monitored by the REBEL. Of these 15 analytes, 10 are observed 
within optimal range at DF = 100x, and 5 are observed within optimal range at DF = 10x. They will want to prepare each 
sample at both DF = 100x and 10x, in separate vials, to quantify all 15 targets.

• Example 3: Milla’s Media Development Lab is interested in all analytes monitored by the REBEL because they create 
formulations for as-needed applications. They will frequently use the RFT whenever they have a new formulation to analyze 
and may need to use several DFs for each new sample tested. In one case, they find that they should prepare each sample 
at DF = 10x to monitor the micronutrients, DF = 100x to monitor analytes at intermediate concentrations, and DF = 500x to 
monitor higher concentrated analytes like AQ, Asp, and Glu. Therefore, they’ll prepare each sample at three DFs (10x, 100x, 
and 500x), in separate vials, to quantify their numerous targets.
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The Results File

• Filename format is:
• [date/time stamp]-[REBEL serial number]-[batch name]-Results.csv

• Ex. 20200322T121701-SN0129-6-March inoculation-Results.csv

• ‘batch name’ is designated by the Name field in batch runsheet .csv file

The –Results.csv file includes data from all replicates in a layout suitable for
creating Pivot Tables and Pivot Charts in Excel

First thing, after opening the Results.CSV file is to Save As .XLSX so any 
changes made throughout processing may be saved

Batch Runsheet .csv File

Results .csv File

Batch Name
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Delimiting a Single Column of Data Labels into Several Columns

1) Select single column with data labels
2) Data > Text to Columns
3) Ensure “Delimited” is selected > Next

4) Select Delimiter 
Example: Underscore
“_”

5) Finish
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Generating a Pivot Table/Chart

Generate a pivot table and pivot 
chart by

• Selecting the entire dataset
Click anywhere in the dataset 
and hit “Ctrl+A”

• Then select
Insert > PivotChart > PivotChart
& PivotTable

• Click OK when prompted
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Construct the Pivot Table / Chart

Large datasets can be quickly organized and 
visualized by rearranging the fields
• Construct the pivot table and chart by

dragging data fields into appropriate ‘areas’

• Results (in mM) are in the ‘Concentration’ field, 
which should be placed in the ‘Values’ area
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Display Concentration Averages

Pivot tables will default to display the
Value Field as a Sum

To change the Value Field to display 
Average:

• Click the dropdown arrow next to Sum of
Concentration > Value Field Settings

• Select Average > OK

The Value Field should now display the 
Average of Concentration
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Range Finding Experiment – Adding Data to Table

Add ‘Dilution Factor’ and ‘Abbreviation’
• ‘Dilution Factor’ should be placed in 

the ‘Filters’ area

• ‘Abbreviation’ should be placed in the 
‘Rows’ area – Note: ‘Rows’ is labeled ‘Axis’ if 
you click on the chart rather than the table
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Range Finding Experiment – Removing Grand Totals

Remove ‘Grand Totals’ row as it is
unnecessary to this analysis

Select any cell in table
Design > Grand Totals (dropdown) 
> Off for Rows and Columns

Grand totals should be removed 
from table for ease of use since 
they’re unnecessary for this 
analysis
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Range Finding Experiment – Removing Undetected Analytes

This will insert a Slicer window 
(right) to allow you to select or 
deselect analytes from your list

Now you have a list of all analytes showing an 
Average Concentration for all Dilutions Factors 

Remove any analyte with a Concentration of

‘#DIV/0!’ – analytes have no reported value

• Select any cell in the table
Insert > Slicer

• Select “Abbreviation”, click OK

• Click “Multi-Select” when the

window on the right appears:
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Range Finding Experiment – Establishing Dynamic Range Boundaries

Delete the copy/pasted list of analytes
Ensure “(All)” is selected for the DF filter

Copy and paste the table below to cell C1 in 
your worksheet
• Equations convert units from µM (dynamic 

range of REBEL) to mM (true concentration of 
analytes) and accounts for DF (cell B1)

• Lower bound for all analytes is 5 µM
• Upper bound is 25, 50, 75, or 100 µM

depending on the analyte
• You’ll receive an error (#VALUE!) since we have 

not selected an individual DF yet, this is 
expected

Note: Boundaries for different sets of analytes can 
be found in Calibration Range table provided by 
FAS during training (left)COPY/PASTE

=5*B1/1000 =100*B1/1000 =75*B1/1000 =50*B1/1000 =25*B1/1000

Lower Boundary Upper Boundary Upper Gln/Glu Upper Cystine Upper B1/B6-OH/B6-
Oxo/NAM/βAla/GABA/Sarcosine
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Range Finding Experiment – Conditional Formatting, Lower Boundary

Set up Conditional Formatting for 
visual cues as to which analytes are 
out of range
• Select all the Concentration cells for

every analyte since all analytes have
the same lower bound

• Apply CF so any value LESS THAN

Lower Boundary will highlight

Conditional Formatting > Highlight 
Cells Rules > Less Than… > Click on cell 
C2 to input > OK

• C2 should be where your equation for 
Lower Boundary is set, if not please 
select appropriate cell for CF, above

Note: Which color you choose doesn’t
matter, default is red
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Range Finding Experiment – Conditional Formatting, Upper Boundaries

Set up further Conditional Formatting
• Select all the Concentration cells for every 

analyte again since most analytes have 
the same upper bound

• Apply CF so any value GREATER
THAN Upper Boundary will highlight

Conditional Formatting > Highlight Cells 
Rules > Greater Than… > Click on cell D2 
to input > OK

• D2 should be where your equation for 
Upper Boundary is set, if not please select 
appropriate cell for CF, above

Note: Which color you choose doesn’t 
matter, default is red but a different 
color than you used for Lower is 
suggested
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Example: B6-OH, GABA, NAM, and βAla 
are the analytes of the seven in this 
Micronutrient/Vitamin list remaining

Range Finding Experiment – Conditional Formatting, Upper Boundaries

Set up CF for Cystine, Gln/Glu, and 
the Micronutrient/Vitamins

• Select Concentration cells for Gln, Glu, 
and Glx, if any remain in the list
Apply CF so any value GREATER THAN cell
E1 will highlight

• Select Concentration cell for Cystine, if it 
remains in the list
Apply CF so any value GREATER THAN cell
F1 will highlight

• Select Concentration cells for any of 
the SEVEN analytes remaining in the 
Micronutrient/Vitamins list (see 
example, left)
Apply CF so any value GREATER THAN cell
G1 will highlight
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Range Finding Experiment – Quick Check

Abovedynamic range is less accurate but possibly useful to see data trends, below range don’t usesinceit’s
below LOQ

Check to ensure everything was set up
properly so far:

1. Choose a DF from the dropdown 
menu in B1

2. Boundary values should change to 
real values

3. Some cells you set CF for will highlight if 
out of range (both above or below)

Example: 10x DF was selected along 
with red highlight/text for CF

All concentrations out of this
calculated range (above and below 
bounds) are highlighted in red
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Range Finding Experiment – Copy Sheet for all DFs

Make a copy of this worksheet for each
DF run in the RFE

Right Click sheet name > Move or Copy…

> Check ‘Create a copy’ > Select

placement of sheet > OK

Label sheets for each DF and select
appropriate DF from dropdown in B1

Example: 10x, 25x, 50x, and 200x DFs were 
run for entire RFE

Make 3 copies of worksheet

Label first ‘10x’, second ‘25x’, third ‘50x’, and 
last ‘200x’

Note: It’s important 
to establish 
bounds and CF 
before making 
copies so you don’t 
have to set them 
for each sheet
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Range Finding Experiment – % Relative Standard Error

This will leave a list of analytes that fall within the calibration range for that specific Dilution Factor

Start with one DF (e.g., ‘10x’)

Make another copy of this worksheet 
and label ‘10x %RSE’

Right Click sheet name > Move or Copy…

> Check ‘Create a copy’ > Select

placement of sheet > OK

Remove color-highlighted analytes
• Highlight all cells of those analyte 

names using Ctrl and paste the list 
elsewhere in the sheet

• Use ‘Row Labels’ dropdown menu in table

• De-select all necessary analytes
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Range Finding Experiment – % Relative Standard Error (cont.)

Delete the copy/pasted list of analytes

Swap ‘Concentration’ for ‘% Standard 
Error’ in the ‘Values’ area, and display 
Average instead of Count (see slide 11 for 
instructions)

Set up Conditional Formatting for 
visual comparison of relative error 
for that DF

• Select all the %SE cells for every analyte

• Apply CF with Color Scale displaying 
higher %RSE in darker colors

Conditional Formatting > Color Scales

• Which color you choose doesn’t matter,
Red - White suggested

Depending on the color scale selected, the column of 
%SE will display color highlights based on relative error 
within the specified range of analytes
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Range Finding Experiment – Replicate Analysis

Make a 3rd copy of the same DF worksheet
(e.g., ‘10x’) and label ‘10x Replicates’

Right Click sheet name > Move or Copy… > 
Check ‘Create a copy’ > Select placement 
of sheet > OK

Add ‘Replicate Number’ to ‘Columns’ area

Use this view of the pivot table/chart to 
compare replicates for why certain 
%RSE are observed
• Are the concentrations for a particular

analyte close to the lower/upper boundary?

• How much does the concentration vary 
from replicate to replicate?

• Is the avg concentration an accurate 
representation of the replicate data set?
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Range Finding Experiment – %RSE and Replicate Analysis for all DFs

Repeat the steps from slides 17 – 19 for each 
of the DFs ran in the RFE

This will create both %RSE and Replicate 
Analysis worksheets for each DF

Right Click sheet name > Move or Copy…

> Check ‘Create a copy’ > Select

placement of sheet > OK

Example: 10x, 25x, 50x, and 200x DFs 
were run for entire RFE

Should currently have the following sheets: 
10x, 10x %RSE, 10x Reps, 25x, 25x %RSE, 25x 
Reps, 50x, 50x %RSE, 50x

Reps, 200x, 200x %RSE, 200x Reps
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Range Finding Experiment – % Relative Standard Error Comparison

Make a 2nd copy of one of the %RSE 
worksheets (e.g., ‘10x %RSE’) and label this 
one ‘%RSE Comparison’

Right Click sheet name > Move or Copy…

> Check ‘Create a copy’ > Select

placement of sheet > OK

Delete the boundaries and then copy and
paste the %RSE tables from each DF into 
this sheet so that they are side by side

Highlight the %SE columns in all the tables 
at once and reset the Conditional 
Formatting  Color Scale (see slide 18) so 
that the color gradient is relative to all 
tables in the worksheet

Depending on the color scale selected, the columns of %SE will 
display color highlights based on relative error of all DFs in the 
worksheet

Use this to compare analytes observed in multiple DFs to 
determine which DF affords the lowest %RSE for that analyte
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Spent Media Analysis

While the RFE is useful for determining optimal dilutions at which to prepare your 
samples, typical use of the REBEL for sample analysis is for Spent Media Analysis (SMA)

Each lab, and even experiments within a single lab, may involve interest in 
different types of analyses of the resulting sample data, examples include:

• Time course study
• Before/after feedings analysis
• Bioreactor comparison
• Commercial or in-house media lot-to-lot comparison

How you visualize the data to best interpret results is experiment-dependent, more 
examples of other ways to view data follow but are not the only way to conduct data 
processing
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View A – Results for All Analytes from All Runs

Configure the PivotTable 
Fields as shown:
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View B – All Analytes in a Single Sample

Configure the PivotTable 
Fields as shown:
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View B – All Analytes in a Single Sample (cont.)

• Select Dilution Factor from 
the dropdown on the chart

• Select Sample Label from 
the dropdown on the chart

If you Select Multiple Items, the 
table and chart will display an 
average value of the data from 
all selected dilution 
factors/samples
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View C – Display One or More Analytes Over All Samples

Configure the PivotTable 
Fields as shown:
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View C – Display One or More Analytes Over All Samples (cont.)

Select specific analytes 
from the Abbreviations 
dropdown at the bottom of 
the chart
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View D – Time Course – All Analytes + Bar Chart

Configure the PivotTable 
Fields as shown:
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View E – Time Course – Select Analytes + Line Graph

Configure the PivotTable 
Fields as shown:
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View F – Time Course – Single Analytes + Bar Chart with %SE

Configure the PivotTable Fields 
as shown:
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Thank you

www.repligen.com

Technical Support | TechSupport@repligen.com

mailto:TechSupport@repligen.com

	PATsmart™ REBEL® System�Guide to Pivot Tables�RFE + SMA Data Processing
	Contents
	REBEL Output File Types – What you’ll find in your Batch folder
	REBEL Output File Types (cont.)
	Range Finding Experiment (RFE)
	Range Finding Experiment (RFE) - Examples
	The Results File
	Delimiting a Single Column of Data Labels into Several Columns
	Generating a Pivot Table/Chart
	Construct the Pivot Table / Chart
	Display Concentration Averages
	Range Finding Experiment – Adding Data to Table
	Range Finding Experiment – Removing Grand Totals
	Range Finding Experiment – Removing Undetected Analytes
	Range Finding Experiment – Establishing Dynamic Range Boundaries
	Range Finding Experiment – Conditional Formatting, Lower Boundary
	Range Finding Experiment – Conditional Formatting, Upper Boundaries
	Range Finding Experiment – Conditional Formatting, Upper Boundaries
	Range Finding Experiment – Quick Check
	Range Finding Experiment – Copy Sheet for all DFs
	Range Finding Experiment – % Relative Standard Error
	Range Finding Experiment – % Relative Standard Error (cont.)
	Range Finding Experiment – Replicate Analysis
	Range Finding Experiment – %RSE and Replicate Analysis for all DFs
	Range Finding Experiment – % Relative Standard Error Comparison
	Spent Media Analysis
	View A – Results for All Analytes from All Runs
	View B – All Analytes in a Single Sample
	View B – All Analytes in a Single Sample (cont.)
	View C – Display One or More Analytes Over All Samples
	View C – Display One or More Analytes Over All Samples (cont.)
	View D – Time Course – All Analytes + Bar Chart
	View E – Time Course – Select Analytes + Line Graph
	View F – Time Course – Single Analytes + Bar Chart with %SE
	Slide Number 35

